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Welcome to OpenBook 
OpenBook is an application that transforms your personal 
computer and scanner into a full-featured reading machine. 
Use any of today’s popular scanners to scan your favorite 
magazine, book, or newspaper article, and let OpenBook 
read that page aloud to you. Or open and edit an electronic 
file from any of today’s most popular applications. With 
OpenBook nothing is left inaccessible, and better yet, you are 
in control of how a page is read and presented.   

System Requirements 
The recommended system requirements for OpenBook 
include a personal computer with Windows 9x, Me, NT 4.0 
with Service Pack 6, 2000, or Windows XP Pro/Home.  

Specification Minimum Requirement 
Processor speed 166 MHz 
RAM 32 MB 
Available hard disk space 
for typical installation 

460 MB 

Video Super VGA display 
Sound Windows compatible sound 

card and speakers 
Keyboard 104-key Keyboard 
Scanner A supported TWAIN-

compatible scanner or a 
supported Hewlett-Packard 
flatbed scanner  

CD ROM Drive  



 

2 

Installing OpenBook 
1. Insert the OpenBook CD into your CD-ROM drive. 
2. The OpenBook Setup program starts. You will hear the 

installation speak the instructions as they appear on 
your screen. Follow these instructions to complete the 
OpenBook installation. 

Note:  Have your software serial number handy. The serial 
number is located on the outside of the box and on 
the outside of OpenBook’s CD jacket. When you 
type in your serial number be sure to include any 
dashes. 

If your OpenBook installation CD does not start automatically, 
go to the Start menu, select Run, and type D:\setup. If your 
CD-ROM drive is not D, substitute the correct drive letter. 

The OpenBook setup program will then begin.  

Choose to run the Typical or Custom installation of 
OpenBook. The Typical installation assumes that you want to 
install the default files along with ViaVoice™ Outloud and 
RealSpeak™ speech software, that you approve of 
OpenBook’s default location on your hard drive, and that you 
want to install the standard launchable programs. Use the 
Custom installation if you want to install additional 
synthesizers, specify which languages are installed, and/or 
specify where OpenBook is stored on your hard drive.  

Note:  When you install OpenBook 7.0 your scanner is 
automatically detected.  

Installing Connect Outloud 
During OpenBook installation you will be asked if you would 
like to install Connect Outloud. Installing Connect Outloud 
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with OpenBook provides you with speech and Braille access 
to the Windows Operating System and many components 
installed as part of that system including Internet Explorer and 
Outlook Express. The new Connect Outloud also provides 
speech support for Adobe® Acrobat Reader. 

If you currently have a screen reading product installed, it is 
recommended that you do not install Connect Outloud without 
consulting the manufacturer of your screen reader. 

Registering OpenBook 
Initial Registration  

Once you have completed the installation of OpenBook, you 
are ready to register your software license with Freedom 
Scientific. 

We encourage you to register your software. Registering your 
software costs you nothing, takes just a few minutes, and is 
the best way for you to receive quality service. Failing to 
register your software prevents us from providing you with 
technical support. 

To register: 

1. Place the Registration disk in your disk drive. 

2. Start OpenBook if it is not already running. 

3. Go to the File Menu and select Open or press CTRL+O. 

4. In the Filename edit box, type a:\registration.ark 
and then press ENTER. 

5. The registration document will open. 

6. Press CTRL+E to toggle to Edit Mode in OpenBook. 

7. Use your ARROW keys to move down the screen and 
enter the information requested. 
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8. When finished, save the information by pressing 
CTRL+S. 

Note:  To save a copy of this form on your computer, 
press ALT+F, A (for Save As) and then press 
ENTER. This saves a copy of the same file in the 
default folder on your hard drive.  

9. If you live in the United States you can send the disk to 
Freedom Scientific in the self-addressed diskette 
envelope included in the software package. (This 
cardboard diskette envelope has the name Freedom 
Scientific embossed in Grade 2 Braille.)  

Changing Your Registration  
If you need to change your registration information, such as 
your address or phone number, open the Registration.ark file 
located on your hard drive under C:\OPENBK7. The same 
questions appear as your initial registration. Change the 
necessary information, save it to a 3.5” floppy and send it to 
Freedom Scientific. 

Uninstalling OpenBook  
To uninstall OpenBook go to the Programs menu and select 
OpenBook 7.0. In the Tools submenu select the Uninstall 
OpenBook option. Uninstalling OpenBook does not uninstall 
Connect Outloud. If you choose to leave Connect Outloud on 
your system, it will run as a demo.  

Uninstalling Connect Outloud 
To uninstall Connect Outloud go to the Programs menu and 
select Connect Outloud 2.0. In the Tools submenu select the 
Uninstall Connect Outloud option.  
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Getting Started 
Launching OpenBook 

OpenBook gives you a variety of ways to launch the program.  
• Press the hot key, ALT+CTRL+O, which is automatically 

assigned when you install OpenBook.  
• Double-click the OpenBook icon on your desktop.  
• Go to the Start menu and select Programs. Choose 

OpenBook 7.0 from the OpenBook 7.0 menu.  

Once launched, OpenBook opens with a blank untitled 
document from which you can begin working or if you prefer, 
you can change the startup document to be the document 
you were working on last. To do this, go to the Settings menu 
and select General Settings (ALT+G, G). In the General 
Settings dialog, press TAB until you arrive on the Open 
Untitled Document on Startup radio button. Press the DOWN 
ARROW key to select the Open Last Document on Startup 
radio button. 

Closing OpenBook  
You can close OpenBook like any other Windows application 
by pressing ALT+F4, pointing the mouse and left clicking on 
the X in the top right hand corner of the window, or selecting 
Exit from the File menu.  

Scanning and Reading 
OpenBook 7.0 combines the best in scanning and reading 
features to convert printed media into electronic format. It 
then displays and reads the content aloud giving you access 
to material that would otherwise be inaccessible or difficult to 
read.  
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When you install OpenBook, IBM’s ViaVoice Outloud and 
ScanSoft’s RealSpeak speech software are also installed. 
You can scan, edit, or read a document. Additionally, you can 
customize the scanning, reading, and display properties of 
OpenBook. 

Here are a few shortcut keys to get you started with 
OpenBook.  
• To have OpenBook read to you, press NUM PAD 

ENTER, F10, or F12.  
• To scan, press NUM PAD INSERT or F4.  
• To toggle between Edit Mode and Read-only Mode, 

press CTRL+E.  
• To silence speech press the CTRL key. 
• To read faster, press CTRL+2. 
• To read slower, press CTRL+1. 



 7 

Getting Help 
Online Help System 

OpenBook’s Online Help System is composed of three 
components, the Contents page with its tree view of books 
and topics, the Index page with its alphabetical listing of 
topics, and the Text View, which displays all topic content. 
When you launch Help, OpenBook automatically begins 
reading the contents of the Text View. To stop reading, press 
the CTRL key. To move from the Text View to the Tree View 
of books and topics, press F6. To return and begin reading 
the contents in the Text View, press F6 again. 

To navigate the books in the tree, use the UP and DOWN 
ARROW keys. The RIGHT ARROW key expands books to 
display its topics, while the LEFT ARROW key closes books. 
When you find the topic you want to read, press ENTER on 
the standard keypad. OpenBook Help displays that topic and 
automatically begins reading the contents.  

Note:  To display the selected topic in the Text View, you must 
press ENTER. Simply moving back to the Text View 
without pressing ENTER does not display or read the 
newly selected topic. 

The Index page is particularly helpful if you are searching for 
a particular topic because it lists help topics in alphabetical 
order. To move between the Contents and the Index pages of 
Help, press CTRL+TAB.  

Navigating the Index’s list of topics is similar to navigating the 
Tree View of the Contents page in that you can use the UP 
and DOWN ARROW keys to move up and down the list of 
topics. Or if you know the topic you want to find, type its first 
letter. For instance, you want information on the Zoom feature 
of OpenBook. You would then type the letter Z. The Index 



 

8 

automatically moves through the list to that topic or to a topic 
that begins with the letter Z. 

You can also navigate OpenBook’s Help System by pressing 
the TAB key. When you press the TAB key, you cycle 
between the three controls in Help. Pressing the TAB key 
once activates the Tree View or Index list. Use the ARROW 
keys to navigate or open and close topics. Pressing the TAB 
key twice activates the Tab Control on the Contents or Index 
page. Use the LEFT and RIGHT ARROW keys to switch 
between the Contents or Index page. Pressing the TAB key 
three times activates the Text View where the topic contents 
are displayed. Here you can press F12 to read or the 
ARROW keys to navigate the contents.  

Context-Sensitive Help 
When you are in a dialog, press SHIFT+F1 or the NUM PAD 
MINUS key to read the context-sensitive help message for 
the current item.  

You can also access context-sensitive help by right-clicking 
with your mouse or by clicking on the ? (question mark) 
symbol at the top right corner of the dialog box. 

Technical Support 
If you do not find the answers to questions or problems that 
you have, contact Freedom Scientific Technical Support, 
(727) 803-8600 or e-mail Support@FreedomScientific.com. 
Office hours are from Monday through Friday 8:30 A.M. to 
7:00 P.M. Eastern Standard Time. 
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Please have the following information on hand: 
• Product serial number used for registration. 
• Product name and version number. 
• Type of computer hardware you are using. 
• Software version number of Windows. 

About OpenBook 
Select About OpenBook from the Help menu to view the 
version number of OpenBook you are currently running and 
its serial number. 



OpenBook Keystrokes
For Reading Keys:

Read Dialog     CTRL+B
Read Status Bar     CTRL+SHIFT+F10
Reading Speed -- Decrease    CTRL+1 or SHIFT NUM PAD ASTERISK 
Reading Speed -- Increase   CTRL+2 or NUM PAD ASTERISK
Read (Say All)     F10, F12 or NUM PAD ENTER 
Speech On/Off Toggle    CTRL+F5

Scanning Keys:  
  
Toggle Recognize Columns   CTRL+SHIFT+Z
Scan (Edit Mode)    F4 or NUM PAD INSERT 
Scan (Read-only Mode)   SPACEBAR, F4, or NUM PAD INSERT
Scanning Status     SHIFT+F4 or NUM PAD / (slash)  

Movement Keys:

Find Text      CTRL+F
Find Next Occurrence of Text   CTRL+SHIFT+F
Go To Bookmark     F9
Go To Page     CTRL+G
Where Am I?     NUM PAD 7 
Move Up One Line    UP ARROW
Move Down One Line    DOWN ARROW
Move Forward One Character 
(Edit Mode)     RIGHT ARROW
Move Back One Character 
(Edit Mode)     LEFT ARROW
Move Forward One Word 
(Read-only Mode)    RIGHT ARROW
Move Back One Word 
(Read-only Mode)    LEFT ARROW
Move Up One Page    NUM PAD PAGE UP
Move Down One Page    NUM PAD PAGE DOWN 
Move Up One Screen    PAGE UP
Move Down One Screen   PAGE DOWN



OpenBook Keystrokes
Highlight Next Word in the Unit  CTRL+DOWN ARROW
Highlight Previous Word in the Unit  CTRL+UP ARROW
Move Spotlight to Previous Unit  CTRL+LEFT ARROW
Move Spotlight to Next Unit   CTRL+RIGHT ARROW
Move Spotlight to Beg. of Doc  CTRL+HOME
Move Spotlight to End of Doc  CTRL+END
Select Line Down         SHIFT+DOWN ARROW
Select Line Up     SHIFT+UP ARROW
Select Page Down (View Page)  SHIFT+PAGE DOWN
Select Page Up (View Page)   SHIFT+PAGE UP
Select Word to the Right    SHIFT+RIGHT ARROW
(Read-only Mode) 
Select Character to the Right     SHIFT+RIGHT ARROW
(Edit Mode) 
Select Word to the Left      SHIFT+LEFT ARROW
(Read-only Mode)  
Select Character to the Left       SHIFT+LEFT ARROW
(Edit Mode)
Select to Beginning of Word   CTRL+SHIFT+LEFT ARROW
(Edit Mode)   
Select Word to the Left    CTRL+SHIFT+LEFT ARROW
(Read-only Mode)  
Select to End of Word (Edit Mode)  CTRL+SHIFT+RIGHT ARROW
Select to Beginning of Page   CTRL+HOME
Select to End of Page    CTRL+END
Select to Beginning of Line   SHIFT+HOME
Select to End of Line    SHIFT+END

Editing Keys:

Copy Text      CTRL+C
Cut Text (Edit Mode)    CTRL+X
Delete Current Page    CTRL+DELETE 
Delete Character     DELETE 
Dictionary      CTRL+D or F8
Edit Mode/Read-only Mode Toggle  CTRL+E
Move Page Down in Page Order  ALT+PAGE DOWN
Move Page Up in Page Order  ALT+PAGE UP
Page Break, Insert    CTRL+ENTER
Page Break, Delete    CTRL+SHIFT+DELETE



OpenBook Keystrokes
Paste Text (Edit Mode)   CTRL+V
Replace Text (Edit Mode)  CTRL+H
Select All Text on Current Page 
(Edit Mode)    CTRL+A
Spell Check    F7 or CTRL+K
Spell Word     CTRL+L, F3 twice, or NUM PAD 5 twice
Spell Word Phonetically  CTRL+SHIFT+L, F3 three times, or
      NUM PAD 5 three times
Thesaurus     CTRL+T or SHIFT+F8
Undo      CTRL+Z

Page Layout Keys:

Start Page Description   CTRL+SHIFT+Y
Enter Guided Layout Mode  CTRL+SHIFT+F5
Exit Guided Layout Mode  ESC
Enter Explore Layout Mode  CTRL+SHIFT+ENTER
Enter Explore Layout Mode
from Guided Layout Mode  ENTER
Exit Explore Layout Mode  ESC
Exit Explore Layout Mode
and place cursor at current
element in editor    ENTER
Pause/Resume Reading
in Guided Layout Mode  NUM PAD ENTER
Read Element Contents/
Pause Reading/Resume 
Reading Element Contents
in Explore Layout Mode  NUM PAD ENTER
Exact View / Text View 
Toggle     CTRL+SHIFT+V
Move to Next Element   CTRL+SHIFT+DOWN  ARROW
Move to Previous Element  CTRL+SHIFT+UP ARROW

Element Navigation Keys:

All Elements    CTRL+SHIFT+A
Section Headings   CTRL+SHIFT+H



OpenBook Keystrokes
Text Blocks      CTRL+SHIFT+B
Headers      CTRL+SHIFT+D
Columns      CTRL+SHIFT+C
Graphics      CTRL+SHIFT+G
Captions      CTRL+SHIFT+N
Tables      CTRL+SHIFT+T
Footers      CTRL+SHIFT+O

Other Useful Keys:

Bookmark, Go To     F9
Bookmark, Insert     CTRL+F9
Bookmark, Delete    CTRL+SHIFT+F9
BuckScan Money Identifier   CTRL+M
Classic Menus Toggle On/Off  F2
Close Current Document   CTRL+F4 or CTRL+W
Context-sensitive Help    SHIFT+F1
Document Properties    CTRL+R
Exit OpenBook     ALT+F4
Help       F1 or - (NUM PAD MINUS)
Help, Context-sensitive Help   SHIFT+- (NUM PAD MINUS)
       or SHIFT+F1
Key Describer Toggle    NUM PAD 1 or CTRL+F12
Menu Key (Classic Menus)   NUM LOCK
New File      CTRL+N
Open File      CTRL+O
Print Current Document   CTRL+P
Properties (of Open Document)  CTRL+R
Save Current Document   CTRL+S
Status Bar Toggle On/Off   SHIFT+F5
Start OpenBook     ALT+CTRL+O
Toggle Windows            CTRL+F6
Word Count     SHIFT+F7

Using the NUM PAD on a portable PC:

You can use OpenBook on a portable notebook or laptop computer. 
However, most portable computers do not have standard 17-key keypads. 
Therefore, we have assigned alternate keys to the OpenBook NUM PAD 



OpenBook Keystrokes
functions.

Menu       F2 
Scan        F4 or SPACEBAR 
Delete Page      CTRL+DELETE 
Speak       F10 or F12 
Select       ENTER 
Escape       ESC 
Key Describer      CTRL+F12 
Where Am I?      SHIFT+CTRL+F12 
Help        F1 
Voice Rate       CTRL+1 and CTRL+2 
Scanning Status      SHIFT+F4 
Move Up       UP ARROW 
Move Down      DOWN ARROW 
Move Left       LEFT ARROW 
Move Right      RIGHT ARROW 
Page Up       PAGE UP 
Page Down      PAGE DOWN 





General:

Key Describer      INSERT+ NUM PAD 1
Where am I?      INSERT+ NUM PAD 3
Beginning of Line     NUM PAD 7
End of Line      NUM PAD 1
Beginning of File     CTRL+NUM PAD 7
End of File       CTRL+NUM PAD 1
Beginning of Page     ALT+NUM PAD 7
Delete       DECIMAL
Page Up       NUM PAD 9
Page Down      NUM PAD 3

Reading Text:
*reading by character is possible only in edit mode
Read Previous Character    NUM PAD 4
Read Current Character    NUM PAD 5
Read Next Character     NUM PAD 6
Read Previous Word     INSERT+ NUM PAD 4
Read Current Word     INSERT+ NUM PAD 5
Read Next Word      INSERT+ NUM PAD 6
Read Current Line     INSERT+ NUM PAD 8
Read Previous Sentence    ALT+NUM PAD 8
Read Current Sentence    ALT+NUM PAD 5
Read Next Sentence     ALT+NUM PAD 2
Read Previous Paragraph    CTRL+NUM PAD 8
Read Current Paragraph    CTRL+NUM PAD 5
Read Next Paragraph     CTRL+NUM PAD 2
Read from Beginning of Line   INSERT+ NUM PAD 7
Read to End of Line     INSERT+ NUM PAD 9
Read Continuously     INSERT+ NUM PAD 2

JAWS Keyboard
Layout Keystrokes



Selecting Text:
*selection by character is only possible in edit mode
Select Prior Character     SHIFT+NUM PAD 4
Select Next Character     SHIFT+NUM PAD 6
Select Prior Line      SHIFT+NUM PAD 8
Select Prior Word     INSERT+SHIFT+ NUM PAD 4
Select Next Word     INSERT+SHIFT+ NUM PAD 6
Select Next Line      SHIFT+NUM PAD 2
Select to Beginning of Line    SHIFT+NUM PAD 7
Select to End of Line     SHIFT+NUM PAD 1
Select to Beginning of Page   CTRL+SHIFT+ NUM PAD 7
Select to End of Page    CTRL+SHIFT+ NUM PAD 1

JAWS Keyboard
Layout Keystrokes



Window-Eyes Keyboard
Layout Keystrokes

General:

Where am I?     DECIMAL
Speak Key      ENTER
Beginning of Line    NUM PAD 7
End of Line     NUM PAD 1

Reading Text:
*reading by character is only possible in edit mode
Read Previous Character   NUM PAD 4
Read Next Character   NUM PAD 6
Read Current Character   NUM PAD 5
Read Previous Line    NUM PAD 8
Read Next Line     NUM PAD 2
Read Current Line    ALT+NUM PAD 8
Read Previous Word    ALT+NUM PAD 4
Read Next Word     ALT+NUM PAD 6
Read Current Word    ALT+NUM PAD 5
Read from Beginning of Line  ALT+NUM PAD 7
Read to End of Line    ALT+NUM PAD 9
Read to End of Screen   ALT+NUM PAD 2



Window-Eyes Keyboard
Layout Keystrokes




